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Important Message About Cartridge Recycling!
Please Read Before Opening Your Inkjet Cartridge Box
At Lexmark, we take our commitment to the environment seriously, and we encourage our customers to participate in our easy, no-cost method for
returning empty Lexmark cartridges to Lexmark for proper recycling. We will insure that cartridges are properly handled with zero waste to landfills.

Go to www.lexmark.com/recycle. Follow instructions to request postage-paid bags. Bags usually arrive within
7–10 days.

Place the empty Lexmark-branded inkjet cartridge(s) in the postage-paid return bag, and then seal the bag. If
you’re sending single-color cartridges, we recommend that you send at least two at a time to maximize the
environmental benefits.

Mail the bag to Lexmark’s recycling partner. The bag is pre-addressed.

Visit www.lexmark.com/recycle to learn more about recycling.
Lexmark-branded cartridges are always made with all new parts, though components may contain recycled material. For warranty returns, call
1-800-332-4120.
This patented printer is licensed for, and designed to work with, only genuine Lexmark inkjet cartridges for the life of the patented printer. You agree
to: (1) use only genuine Lexmark inkjet cartridges with this printer except as otherwise provided below, and (2) pass this license/agreement to any
subsequent user of this printer. The patented Lexmark inkjet cartridges and their contents are licensed subject to a restriction that they may be used
only once. After this single use, the license to use the print cartridges and their contents terminates, and you agree to return them only to Lexmark
for recycling. Replacement inkjet cartridge(s) sold without these terms are available through www.lexmark.com and may be refilled by you, or a third
party, as the only cartridge alternative to be used with the licensed printer.

Important safety information

Connect the power cord to a properly grounded electrical outlet that is near the product and easily accessible.

Do not place or use this product near water or wet locations.

Use only the power supply and power cord provided with this product or the manufacturer's authorized replacements.

Use only the telecommunications (RJ-11) cord provided with this product or a 26 AWG or larger replacement when connecting this product to the
public switched telephone network.

CAUTION—POTENTIAL INJURY:  Do not cut, twist, bind, crush, or place heavy objects on the power cord. Do not subject the power cord to
abrasion or stress. Do not pinch the power cord between objects such as furniture and walls. If any of these things happen, a risk of fire or
electrical shock results. Inspect the power cord regularly for signs of such problems. Remove the power cord from the electrical outlet before
inspecting it.

CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or make any electrical or cabling
connections, such as the fax feature, power cord, or telephone, during a lightning storm.
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About your printer

Finding information about the printer
The Quick Reference Guide contains instructions on adding your printer to a wireless network, setting up a fax
connection, and accomplishing common printer tasks like printing, copying, scanning, and faxing. It also includes
information on troubleshooting printer setup issues as well as solving basic networking and faxing problems.

For additional information, see the following:

What are you looking for? Find it here

Initial setup instructions • Quick Setup Sheet

• Hardware Setup Wizard*

Additional setup and instructions for using the printer Comprehensive User's Guide installed automatically with the printer
software.*

For Windows users

After installing your printer, you can access the User's Guide from
the printer program folder:

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer
program folder from the list.

3 Select View User's Guide.

For Macintosh users

1 From the Finder desktop, navigate to:

Applications > select your printer folder

2 Double-click User's Guide.

Help using the printer software Software Help installed automatically with the printer software.*

Click Help from any printer software program or application.

The latest supplemental information, updates, online
customer support, and telephone support

Support Web site—http://support.lexmark.com

* Available on the installation software CD and on the Lexmark Support Web site at http://support.lexmark.com.

Minimizing your printer's environmental impact
We are committed to protecting the environment and are continually improving our printers to reduce their
environmental impact. By selecting certain printer settings or tasks, you may be able to reduce your printer's
environmental impact even further.

About your printer
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Conserving energy
• Activate Eco-Mode. This feature sets the screen brightness to low and sets the printer to change to Power Saver

mode after the printer is left idle for 10 minutes.

• Select the lowest Power Saver timeout. The Power Saver feature puts the printer in a minimum-power standby
mode after the printer has been idle for a set amount of time (the Power Saver timeout).

• Share your printer. Wireless/network printers allow you to share a single printer among multiple computers, thus
conserving energy and other resources.

Conserving paper
• Activate Eco-Mode. On select printer models, this feature sets the printer to automatically print on both sides of

the paper (duplex) for copy and fax jobs, and for printing in Windows and Mac OS X version 10.6 or later.

• Print more than one page image on one side of the paper. The Pages per Sheet feature allows you to print multiple
pages on one sheet. You can print up to 4 page images on one side of a sheet of paper.

• Print on both sides of the paper. Duplexing lets you print on both sides of the paper manually or automatically
(depending on your printer model).

• Preview print jobs before printing. Use the preview features found in Toolbars, the Print or Print Preview dialog,
or the printer display (depending on your printer model).

• Scan and save. To avoid printing multiple copies, you can scan documents or photographs and save them to a
computer program, application, or flash drive for presentation.

• Use recycled paper.

Conserving ink
• Use Quick Print or Draft Mode. These modes can be used to print documents using less ink than normal and are

recommended for printing documents that are mostly text.

• Use High Yield cartridges. Inks in High Yield cartridges allow you to print more pages with fewer cartridges.

• Clean the printhead. Before replacing and recycling your ink cartridges, try using the “Clean Printhead” and “Deep
Clean Printhead” features. These features clean the printhead nozzles to improve the quality of your prints.

Recycling
• Return ink cartridges for reuse or recycling through the Lexmark Cartridge Collection Program. To return an ink

cartridge, go to www.lexmark.com/recycle. Follow the instructions to request a postage-paid bag.

• Recycle the product packaging.

• Recycle your old printer instead of throwing it away.

• Recycle paper from discarded print jobs.

• Use recycled paper.

To read the Lexmark Environmental Sustainability Report, see www.lexmark.com/environment.

Printer models
The installation software CD that came with your printer works for the following printer models:

• LexmarK S815

• Lexmark S816

About your printer
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Printer features
Your printer comes with full features that will help you manage and accomplish printing and imaging tasks:

• Wireless networking—Print and scan from virtually anywhere in your home or office over a secure wireless network,
as well as share the printer among multiple computers.

• Intuitive touch screen—Use the full-featured color touch screen for fast, easy access to all the printer menus. The
large screen also allows you to view, edit, and print photos directly from your digital camera or memory device
without using a computer.

• Print—Print documents and PDFs faster from a computer, from a USB flash drive, or from a Bluetooth device. Built-in
two-sided printing lets you save money and the environment.

• Copy—Copy documents and photos with one-touch, computer-free black or color copying. Enjoy 25% to 400%
reduction and enlargement capacity.

• Scan—Scan documents and photos fast and easily with the high-resolution flash scanner. Easily scan to a memory
device or to multiple laptops or PCs over a secure wireless network with up to 1200 x 4800 optical resolution.

• Fax—Do standalone black and color faxing at 33.6 Kbps modem speed. Other fax features include 99 speed dials,
automatic redial, junk fax blocking, and caller ID.

• Photo printing—Print high-quality, long-lasting photos directly from digital memory cards, PictBridge-enabled
digital cameras, and USB flash drives. Select photos to print using the proof sheet for computer-free printing.

• SmartSolutions—Simplify printer tasks that you frequently repeat by creating and customizing your printer
solutions. Using the SmartSolutions toolkit on the Web, you can choose the printer tasks that you often perform,
apply your custom settings, and download them to your printer as shortcuts that you can easily access anytime.
You can also customize your printer with solutions that display your online calendars, online photo albums, RSS
feeds, and more.

• Eco-Mode—Save energy and paper by activating Eco-Mode. It automatically dims the printer display light, puts the
printer into Power Saver mode after 10 minutes of inactivity, and prints on both sides of the paper for print, copy,
and fax jobs.

Setting up the printer
1 Unpack the printer.

About your printer
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Notes:

• Place the printer near the computer during setup. If you are setting up on a wireless network, then you may
move the printer after setup is complete.

• Do not attach the USB cable until prompted to do so.

• Contents may vary by model and region.

2 To initiate printer setup using a computer, insert the installation software CD, or download the printer driver.

With a CD or DVD drive (Windows/Macintosh): Without a CD or DVD drive or for Linux:

Note: If the Welcome screen does not appear after a minute, then see
“Welcome screen did not appear during installation” on page 74.

Download the printer driver from
www.lexmark.com.

3 Remove tape and packing material from all areas of the printer.

About your printer

10

http://www.lexmark.com


4 Use the slider to extend the paper guides.

5 Load paper.

1

2

6 Extend the paper exit tray.

2
1

About your printer
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7 Connect the power cord only.

21

Note: Do not attach the USB cable yet.

8 Make sure the printer is on.

9 Set the language on the printer control panel, and then touch OK.

OK

Francais

EnglishEnglish

Espanol~

Suomi

10 Confirm the language, and then touch Accept.

NoNoYesYes

Language

You have chosen English as the language
for your printer.

Are you sure?

About your printer
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11 Set the country or region, and then touch Accept.

AcceptAccept

USAUSA

UruaguayUruaguay

US Virgin IslandsUS Virgin Islands

VenezuelaVenezuela

Country / RegionCountry / Region

12 Set the date, and then touch Accept.

AcceptAcceptSet DateSet Date

MonthMonth

6

DayDay

15

Year

2008

13 Set the time, and then touch Accept.

AcceptAcceptSet TimeSet Time

12 :00 AMAM

14 Set the time zone, and then touch Accept.

AcceptAccept

Estern (GMT - 5:00)Estern (GMT - 5:00)

Central (GMT - 6:00)Central (GMT - 6:00)

Mountain (GMT - 7:00)Mountain (GMT - 7:00)

Pacific (GMT - 8:00)Pacific (GMT - 8:00)

Choose a Time ZoneChoose a Time Zone

About your printer

13



15 Open the printer.

Behind the printhead access door, you will find the touch-screen cloth and the customer support label, which
identifies the model number of the printer, the customer support hot line, the ink cartridge information, and the
MAC address.

16 Unpack the cartridges.

If your ink cartridge comes with a twist cap, then twist and remove the cap.

About your printer
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If your ink cartridge comes with a muzzle cap, then remove the cap.

17 First, install each color ink cartridge. Then, use two hands to install the black cartridge.

Note: Install the new ink cartridges immediately after removing the protective cap to avoid exposing the ink to air.

18 Close the printer.

About your printer
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19 From the printer control panel, touch Continue to print an alignment page.

Notes:

• Do not remove the page until printing stops. The alignment page may take a while to print and will move in
and out during the process.

• Streaks on the alignment page are normal and not an indication of a problem.

• The alignment page that prints may differ from the one shown.

• Recycle the alignment page.

Understanding the parts of the printer

1
2 3

6

7

1011

89

4

5

Use the To

1 Scanner lid Access the scanner glass.

2 Scanner glass Scan, copy, or fax photos and documents.

3 Scanner clip Hold photos, cards, or other small media in place.

4 Placement corner Correctly place photos and documents on the scanner glass.

About your printer
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Use the To

5 Printer control panel with touch screen Operate the printer.

6 Paper support • Load paper.

• Access paper jams.

7 Paper guide adjustment lever Adjust the paper guides.

8 PictBridge and USB port Connect a PictBridge-enabled digital camera or a flash drive to the printer.

9 Memory card slot Insert a memory card.

10 Front door Access the ink cartridges.

11 Paper exit tray Hold paper as it exits.

1

3

2

4

5

6

11
13

7 8

9

10
12

Use the To

1 Customer support label Identify the model number of the printer, the customer
support hot line, the ink tank information, and the MAC
address.

2 Front door Access the ink cartridges.

3 Printhead access door • Access the printhead.

• Access paper jams.

4 Cloth storage pocket Store the touch-screen cloth.

5 Ink cartridge access Install, replace, or remove ink cartridges.

6 Paper support • Load paper.

• Access paper jams.

7 LINE Port

LINE

Connect the printer to an active telephone line through
a standard wall jack (RJ-11), DSL filter, VoIP adapter, or
any other adapter that allows you to access the phone
line to send and receive faxes.

About your printer
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Use the To

8 EXT Port

EXT

Connect additional devices (telephone or answering
machine) to the printer and the telephone line. Use this
port if you do not have a dedicated fax line for the printer,
and if this connection method is supported in your
country or region.

9 Power supply with port Connect the printer to or disconnect the printer from a
power source.

10 Fax cover Protect the fax area.

11 Duplex unit • Print on both sides of a sheet of paper.

• Access paper jams.

12 Duplex button Release the duplex unit.

13 USB port Connect the printer to a computer using a USB cable.

Warning—Potential Damage: Do not touch the USB port
except when plugging in or removing a USB cable or
installation cable.

1

2

Use the To

1 Power supply with port Connect the printer to or disconnect the printer from a power source.

Note: The power supply input is 100-240 V AC at 0.7 A (50/60 Hz). The power supply output
is 30 V DC at 1.07 A.

2 Power supply cover Protect the power supply.

Using the printer control panel
Note: The icons appear when they are selectable on the current screen. If an icon does not appear, then the function
is not available.

About your printer
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1

3

4

5

6

7

2

Use To

1 Back • Return to the previous screen.

• Exit from one menu level to a higher one.

2 Touch-screen display

Note: The display is turned off in Power Saver mode.

• Navigate the printer menus.

• Change settings.

• View printer messages and animation.

3 Home Return to the home screen.

4 Help View Help text messages.

5 Cancel Cancel the current job or task.

6 Start Start a job, depending on which mode is selected.

7 Power • Turn the printer on and off.

• Switch to Power Saver mode.

Note: When the printer is on, press  to switch to Power
Saver mode. Press and hold  for three seconds to turn
off the printer.

About your printer
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Understanding the home screen
After the printer is turned on and a short warm-up period occurs, the display shows the home screen. Use the home
screen selections to initiate an action, such as copying or faxing, or to change printer settings.

1 2 3

PictBridge Memory Device Smart Solutions

6 5 4

Display item Description

1 Copy

AA

Access the copy menu and make copies.

2 Scan Access the scan menu and scan documents.

3 Fax Access the fax menu and send faxes.

4 Memory Device View, select, print, or e-mail photos and documents.

Note: This icon appears only when you return to the home screen while a memory card or flash
drive is connected to the printer.

PictBridge View, select, or print photos.

Note: This icon appears only when you return to the home screen while a PictBridge-enabled
camera is connected to the printer.

5 SmartSolutions Open the SmartSolutions menu.

About your printer
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Display item Description

6 Ink levels icon • View the current ink levels of the installed cartridges.

• Access cartridge maintenance and information functions.

7 Setup icon Access the setup menu and change printer settings.

8 2-Sided icon

1
2

1-Sided icon

21

Print on both sides or on one side of a sheet of paper.

Note: These icons appear interchangeably depending on which setting you selected.

9 Eco-Mode icon Activate Eco-Mode to select the following options:

• Print on both sides of the paper (duplex).

• Change to Power Saver mode after the printer is left idle for 10 minutes.

• Set screen brightness to low.

10 Wi-Fi indicator Check the wireless status and access the wireless network settings.

About your printer
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Using memory cards and flash drives

Using a memory card or flash drive with the printer
Insert a memory card into the card slot or a flash drive into the USB port.

Inserting a memory card Inserting a flash drive

MEMORY STICK

Notes:

• Insert the card with the brand name label facing up.

• Make sure any arrows on the card point toward the
printer.

• If necessary, connect the memory card to the adapter
that came with it.

• Make sure that the memory card inserted is supported
by the printer. For more information, see “Supported
memory cards and file types” on page 23.

FLA
SH

D
R

IV
E

Notes:

• The flash drive uses the same port that is used for a
PictBridge camera cable.

• An adapter may be necessary if your flash drive does not
fit directly into the port.

Warning—Potential Damage: Do not touch any cables, any network adapter, any
connector, the memory device, or the printer in the areas shown while actively printing,
reading, or writing from the memory device. A loss of data can occur.

The Memory Device screen appears on the display.

Notes:

• If the printer does not recognize the memory device, then remove and reinsert a supported one.

• If a flash drive or a digital camera set to mass storage mode is inserted into the USB port while a memory card is
in the card slot, then a message appears on the display prompting you to choose which memory device to use.

About your printer
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Supported memory cards and file types

Memory Card File Type

• Secure Digital (SD)

• Secure Digital High Capacity (SDHC)

• Micro Secure Digital (with adapter) (Micro SD)

• Mini Secure Digital (with adapter) (Mini SD)

• MultiMedia Card (MMC)

• Reduced Size MultiMedia Card (with adapter) (RS-MMC)

• MultiMedia Card mobile (with adapter) (MMCmobile)

• Memory Stick

• Memory Stick PRO

• Memory Stick Duo (with adapter)

• Memory Stick PRO Duo (with adapter)

• xD-Picture Card

• xD-Picture Card (Type H)

• xD-Picture Card (Type M)

Documents:

• .doc (Microsoft Word)

• .xls (Microsoft Excel)

• .ppt (Microsoft PowerPoint)

• .pdf (Adobe Portable Document Format)

• .rtf (Rich Text Format)

• .docx (Microsoft Word Open Document Format)

• .xlsx (Microsoft Excel Open Document Format)

• .pptx (Microsoft PowerPoint Open Document Format)

• .wpd (WordPerfect)

Images:

• JPEG

• TIFF

About your printer
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Setting up the printer on a wireless network

Finding more information about the printer
The Quick Reference Guide helps you add the printer to your wireless network and troubleshoot basic networking
problems.

For additional networking information or other information about the printer, see the comprehensive User's Guide
available in your printer program folder, on the installation software CD, or on our Web site at
http://support.lexmark.com.

For Windows users
1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Select View User's Guide.

For Macintosh users
1 From the Finder, double-click the printer folder.

2 Double-click User's Guide.

Information you will need to set up the printer on a wireless
network
To set up the printer for wireless printing, you need to know:

• The name of your wireless network, which is also known as the SSID (Service Set Identifier)

• If encryption was used to secure your network

• The security key (either a WEP key or WPA/WPA2 passphrase)

To locate the network WEP key or WPA/WPA2 passphrase, view your access point (wireless router) settings and
check the security information.

If your access point is using WEP security, then the WEP key should be:

• Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a
keyboard.

If your access point is using WPA or WPA2 security, then the WPA passphrase should be:

• Exactly 64 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• From 8 to 63 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a keyboard.
ASCII characters in a WPA passphrase are case-sensitive.

Setting up the printer on a wireless network
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If your wireless network is not using security, then you will not have a security key.

Note: If you do not know the SSID of the network that your computer is connected to, then launch the wireless utility
of the computer network adapter and look for the network name. If you cannot find the SSID or the security information
for your network, then see the documentation that came with the access point, or contact your system support person.

Supported network security options
The printer supports three wireless security options: no security, WEP, and WPA/WPA2.

No Security
It is not recommended to use no security at all on a home wireless network. Using no security means that anyone within
range of your wireless network can use your network resources—including Internet access— if your wireless network
is connected to the Internet. The range of your wireless network may extend far beyond the walls of your home, allowing
access to your network from the street or from your neighbors’ homes.

WEP
WEP (Wired Equivalent Privacy) is the most basic and the weakest type of wireless security. WEP security relies on a
series of characters called the WEP key.

Every device on the wireless network must use the same WEP key. WEP security can be used on both ad hoc and
infrastructure networks.

A valid WEP key has:

• Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a
keyboard.

WPA/WPA2
WPA (Wi-Fi Protected Access) and WPA2 (Wi-Fi Protected Access 2) offer stronger wireless network security than WEP.
WPA and WPA2 are similar types of security. WPA2 uses a more complex encryption method and is more secure than
WPA. Both WPA and WPA2 use a series of characters, called the WPA pre-shared key or passphrase, to protect wireless
networks from unauthorized access.

A valid WPA passphrase has:

• Exactly 64 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• From 8 to 63 ASCII characters. ASCII characters are letters, numbers, punctuation, and symbols found on a keyboard.
ASCII characters in a WPA passphrase are case-sensitive.

Every device on the wireless network must use the same WPA passphrase. WPA security is an option only on
infrastructure networks with access points (wireless routers) and network cards that support WPA. Most newer wireless
network equipment also offer WPA2 security as an option.

Note: If your network uses WPA or WPA2 security, then select WPA Personal when you are prompted to select the
type of security your network uses.

Setting up the printer on a wireless network
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What is Wi-Fi Protected Setup?
Wi-Fi Protected Setup (WPS) is a simple and secure configuration that allows you to establish a wireless home network
and enable network security without requiring prior knowledge of Wi-Fi technology. It is no longer necessary to
configure the network name (SSID) and WEP key or WPA passphrase for network devices.

Note:  WPS supports only networks that communicate through access points (wireless routers).

The printer supports the following methods in connecting to a wireless network:

• Personal Identification Number (PIN)—A PIN on the printer is entered into the wireless settings of the access point.

• Push Button Configuration (PBC)—Buttons on both the printer and the access point are pushed within a given period
of time.

Look for any of these identifier marks to check if your access point is WPS certified:

You can find these WPS logos on the side, back, or top of your access point.

For more information on accessing the wireless settings and determining the WPS capability of your access point, see
the documentation that came with the access point or contact your system support person.

Installing the printer on a wireless network
Before you install the printer on a wireless network, make sure that:

• Your wireless network is set up and working properly.

• The computer you are using is connected to the same wireless network where you want to set up the printer.

For Windows users
1 Close all open software programs.

2 Insert the installation software CD.

If the Welcome screen does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

3 Follow the instructions on the Welcome screen to set up the printer.

For Macintosh users
1 Close all open software applications.

2 Insert the installation software CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

Setting up the printer on a wireless network
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3 Double-click Install.

4 Follow the instructions on the installation dialog to set up the printer.

Configuring the printer wirelessly using WPS (Windows only)
With Wi-Fi Protected Setup (WPS), it is easy to add computers or printers to your wireless network because the SSID
and WPA passphrase are automatically detected and configured for you.

1 Make sure your access point (wireless router) supports WPS.

2 Insert the installation software CD and follow the instructions on the computer screen.

Notes:

• If you are using the PIN method to add your printer using WPS, then make sure you type all eight digits when you
are asked to enter your PIN.

• To use WPS to configure the printer wirelessly, all of the devices on your wireless network must support WPS. If
any device on your network does not support WPS, then you must type the SSID and security information when
prompted.

Installing the printer on other computers
Once the printer is set up on the wireless network, it can be accessed wirelessly by any other computer on the network.
However, you will need to install the printer driver on every computer that will access it. You do not need to configure
the printer again, although you will need to run the setup software on each computer to install the driver.

For Windows users
1 Close all open software programs.

2 Insert the installation software CD.

If the Welcome screen does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

3 Follow the instructions on the computer screen for installing a configured printer on a new computer.

For Macintosh users
1 Close all open software applications.

2 Insert the installation software CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.

3 Double-click Install.

4 Select My printer is already set up. I am installing it on a new computer.

5 Click Continue, and then follow the instructions on the computer screen for installing a configured printer on a new
computer.
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Interpreting the colors of the Wi-Fi indicator
The Wi-Fi indicator can be viewed only from the printer home screen. If the home screen does not appear, then do the
following:

1 If necessary, turn on the printer. Make sure it is not in Power Saver mode.

2 From the printer control panel, touch .

Wi-Fi indicator Network status of the printer

• The printer is not connected to a wireless network.

• The printer has not yet been configured for a wireless network.

• The printer is configured for an ad hoc connection to your computer, but the
computer is currently turned off.

!
• The printer is out of the range of the access point (wireless router).

• The printer is trying to communicate with the access point, but the access point is
turned off or not working properly.

• The access point has been turned off and back on, and the printer is trying to establish
communications with the network.

• The wireless settings of the printer may no longer be valid.

Check if the SSID, WEP key or WPA passphrase, security type, and IP address that
the printer uses are still correct.

• The printer is connected to a wireless network and is ready for use.

• The printer is connected to your computer through an ad hoc connection.

Special wireless installation instructions
The following instructions apply to customers outside of North America who are using a wireless broadband box. Some
examples of these boxes include LiveBox, AliceBox, N9UF Box, FreeBox, and Club Internet.

Before you begin
• Make sure your box is wireless-enabled and activated to work on a wireless network. For more information about

configuring the box to work wirelessly, see the documentation that came with your box.

• Make sure your box is turned on and that your computer is on and connected to your wireless network.

Adding the printer to your wireless network
1 Set up your printer for wireless networking using the setup instructions provided.

Stop when you are prompted to select a network.

2 If there is an association/registration button on the back of your box, then press it before selecting a network.

Note: After pressing the association/registration button, you have five minutes to complete the printer installation.

3 Return to the computer screen.

From the wireless networks list that appears, select your network, and then click Continue.
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If your wireless network does not appear in the list:

a Connect to another wireless network.

For Windows users
Click Unlisted Network.

For Macintosh users
Select Other Wireless Network from the list, and then click Continue.

b Enter the details about your wireless network.

Note: Your WEP, WPA, or WPA2 key may be obtained from the bottom of the box, the documentation that
came with the box, or from the box Web page. If you have already changed the key for your wireless network,
then use the key you created.

4 Follow the instructions on the computer screen to complete installation.
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Setting up the printer to fax

Step 1: Connect the printer to the telephone line
Check the scenarios below and follow the setup that is applicable to your telephone service.

Scenario 1: Standard telephone line

Setup 1: Printer is connected to a dedicated fax line

To connect:
Connect the cable from the wall jack to the  port of the printer.

Tips for this setup:
• You can set the printer to receive faxes automatically (Auto Answer On) or manually (Auto Answer Off).

• If you want to receive faxes automatically (Auto Answer On), then set the printer to pick up on any number of rings
that you want.
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Setup 2: Printer is sharing the line with an answering machine

Connected to the same telephone wall jack

PHONE LINE

To connect:

1 Connect the cable from the wall jack to the  port of the printer.

2 Remove the protective plug from the  port of the printer, and then connect the answering machine to the port.
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Connected to different wall jacks

PHONE LINE

To connect:
Connect the cable from the wall jack to the  port of the printer.

Tips for this setup:
• If you have only one telephone number on your line, then you need to set the printer to receive faxes automatically

(Auto Answer On).

• Set the printer to pick up calls two rings after the answering machine. For example, if the answering machine picks
up calls after four rings, then set the printer to pick up after six rings. This way, the answering machine picks up
calls first and your voice calls are received. If the call is a fax, then the printer detects the fax signal on the line and
takes over the call.

• If you subscribe to a distinctive ring service provided by your telephone company, then make sure that you set the
correct ring pattern for the printer. Otherwise, the printer will not receive faxes even if you have set it to receive
faxes automatically.
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Setup 3: Printer is sharing the line with a telephone subscribed to voice mail service

To connect:

1 Connect the cable from the wall jack to the  port of the printer.

2 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.

Tips for this setup:
• This setup works best if you subscribe to a distinctive ring service. If you have distinctive ring service, then make

sure that you set the correct ring pattern for the printer. Otherwise, the printer will not receive faxes even if you
have set it to receive faxes automatically.

• If you have only one telephone number on your line, then you need to set the printer to receive faxes manually
(Auto Answer Off).

When you answer the telephone and you hear fax tones, press *9* or the manual answer code on the telephone
to receive the fax.

• You can also set the printer to receive faxes automatically (Auto Answer On), but you need to turn off the voice
mail service when you are expecting a fax. This setting works best if you are using voice mail more often than fax.
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Scenario 2: Digital Subscriber Line (DSL)

A Digital Subscriber Line splits your regular telephone line into two channels: voice and Internet. Telephone and fax
signals travel through the voice channel, and Internet signals pass through the other channel. This way, you can use
the same line for analog voice calls (including faxes) and digital Internet access.

To minimize interference between the two channels and ensure a quality connection, you need to install a DSL filter
for the analog devices (fax machine, telephone, answering machine) in your network. Interference causes noise and
static on the telephone, failed and poor quality faxes for the printer, and slow Internet connection on your computer.

To install a filter for the printer:

1 Connect the line port of the DSL filter to the wall jack.

2 Connect a telephone cable from the  port on the back of the printer to the phone port on the DSL filter.

3 To continue using a computer for Internet access, connect the computer to the DSL HPN port on the DSL filter.

4 To connect a telephone to the printer, remove the protective plug from the  port of the printer and then connect
the telephone to the port.
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Scenario 3: VoIP telephone service

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the port labeled Phone Line 1 or Phone Port  on the VoIP adapter.

The port labeled Phone Line 2 or Fax Port is not always active. You may need to pay extra to your VoIP provider if
you want to activate the second phone port.

3 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.

Tips for this setup:
• To make sure that the phone port on the VoIP adapter is active, plug an analog telephone into the phone port, and

then listen for a dial tone. If you hear a dial tone, then the port is active.

• If you need two phone ports for your devices but do not want to pay extra, then do not plug the printer into the
second phone port. You can use a phone splitter. Plug the phone splitter into the Phone Line 1 or Phone Port, and
then plug the printer and telephone into the splitter.

Make sure you use a phone splitter, not a line splitter. To make sure that you are using the correct splitter, plug an
analog telephone into the splitter and then listen for a dial tone.
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Scenario 4: Digital telephone service through a cable provider

Setup 1: Printer is connected directly to a cable modem

Follow this setup if you normally connect your telephone to a cable modem.

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the port labeled Phone Line 1 or Phone Port  on the cable modem.

The port labeled Phone Line 2 or Fax Port  is not always active. You may need to pay extra to your cable provider
if you want to activate the second phone port.

3 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.

Tips for this setup:
• To make sure that the phone port on the cable modem is active, plug an analog telephone into the phone port, and

then listen for a dial tone. If you hear a dial tone, then the port is active.

• If you need two phone ports for your devices but do not want to pay extra, then do not plug the printer into the
second phone port. You can use a phone splitter. Plug the phone splitter into the Phone Line 1 or Phone Port , and
then plug the printer and telephone into the splitter.

Make sure you use a phone splitter, not a line splitter. To make sure that you are using the correct splitter, plug an
analog telephone into the splitter and then listen for a dial tone.
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Setup 2: Printer is connected to a wall jack; cable modem is installed elsewhere in the house

Follow this setup if your cable provider activated the wall jacks in your house so that you do not have to plug your
devices into the cable modem. Your cable telephone service comes from the wall jacks.

To connect:

1 Connect the cable from the wall jack to the  port of the printer.

2 Remove the protective plug from the  port of the printer, and then connect the telephone to the port.

Scenario 5: Country- or region-specific setup
Different countries or regions have different types of telephone wall jacks. The standard wall jack adopted by most
countries or regions is the Registered Jack-11 (RJ-11). You need to have an RJ-11 plug, or a telephone cable that has an
RJ-11 connector, so you can connect a device to an RJ-11 wall jack.

The fax ports on the back of the printer and the telephone cable that comes with the printer have RJ-11 connectors. If
you have a different type of connector in your country or region, then you may need to use an RJ-11 adapter.
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Connecting the printer to a non-RJ-11 wall jack

EXTLINE

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the RJ-11 adapter, and then connect the adapter to the wall jack.

3 If you want to connect another device (telephone or answering machine) to the same wall jack, and if the device
has a non-RJ 11 connector, then connect it directly to the wall jack.

Notes:

• Do not remove the wrap plug from the  port of the printer.

• The printer may not come with an RJ-11 adapter in your country or region.
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If the additional device (telephone or answering machine) has an RJ-11 connector, then you can remove the wrap plug
and connect the device to the  port of the printer.

Connecting the printer in countries or regions that use serial connection

In some countries or regions, you need to plug all devices into the wall jack. You cannot plug a telephone or answering
machine into the  port of the printer. This is called serial connection.

Austria Germany Portugal

Belgium Ireland Spain

Denmark Italy Sweden

France Netherlands Switzerland

Finland Norway United Kingdom

Warning—Potential Damage: If your country or region is on the list, then do not remove the wrap plug from the 
port of the printer. It is necessary for the proper functioning of the devices on the telephone line.
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EXTLINE

To connect:
Connect the cable from the wall jack to the  port of the printer.

Connecting the printer to a wall jack in Germany

The German wall jack has two kinds of ports. The N ports are for fax machines, modems, and answering machines. The
F port is for telephones.

N F N
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Connect the printer to any of the N ports.

PHONE LINE

N F N

To connect:

1 Connect one end of a telephone cable to the  port of the printer.

2 Connect the other end of the cable to the RJ-11 adapter, and then connect the adapter to an N port.

3 If you want to connect a telephone and answering machine to the same wall jack, then connect the devices as
shown.

Step 2: Check the dial tone
A dial tone lets you know if the telephone line is working or if the printer is properly connected to the telephone line.

Make sure the telephone line and the wall jack are working
1 Plug an analog telephone into the wall jack.

2 Listen for a dial tone through the telephone handset.

If you hear a dial tone, then the telephone line and the wall jack are working.

Make sure the printer is properly connected to the telephone line
1 While the printer is connected to a telephone line through the  port on the back of the printer, plug an analog

telephone into the  port of the printer.

2 Listen for a dial tone.

If you hear a dial tone, then the printer is properly connected to the telephone line.
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If you do not hear a dial tone, then review Step 1 or see the “Fax troubleshooting checklist” on page 88.

Step 3: Set your fax name and fax number
Your user information includes your name or company name, your fax number (which is your telephone number, unless
you have a dedicated fax telephone line), and the time and date on your fax machine when a transmission is made.
This information appears in the header and footer of the faxes that you send.

Some countries or regions require the fax number and fax name for you to send a fax, and some fax machines block
anonymous faxes. Make sure to enter your fax number and fax name correctly. This is the information that identifies
you as the sender in all the faxes that you send.

1 From the home screen, navigate to:

 > Fax Setup > Dialing and Sending > Fax Name

2 Enter your name or company name, and then touch OK.

3 Touch Fax Number.

4 Enter your fax number or telephone number, and then touch Accept.

Step 4: Set the printer to receive faxes automatically or manually
If the printer is connected to a dedicated fax line or sharing the line with an answering machine, then set the printer
to receive faxes automatically. If the printer is sharing the line with a telephone subscribed to voice mail service, then
set the printer to receive faxes manually.

1 From the home screen, navigate to:

 > Fax Setup > Ringing and Answering >  Auto Answer

2 Select an Auto Answer setting, and then touch Accept.

Step 5: Set the number of rings
If you set Auto Answer to On in Step 4, then do the following. If you set Auto Answer to Off, then proceed to Step 6.

If you subscribe to Distinctive Ring
Setting the correct ring is important if you subscribe to the Distinctive Ring Pattern Detection (DRPD) feature offered
by telephone companies. This feature allows you to have multiple telephone numbers on one telephone line. Each
telephone number has a designated ring pattern (single ring, double ring, triple ring, or double and triple ring). The
different ring patterns let you know what telephone number was dialed, and what device you should use to answer
the call.

Assign one of your telephone numbers to the printer as the fax number, and then set the printer to answer the ring
pattern of that number. If the pattern is set incorrectly, then the printer rings, but does not receive the fax.

1 From the home screen, navigate to:

 > Fax Setup > Ringing and Answering > Ring Pattern

2 Select the ring pattern for the printer, and then touch Accept.
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If you do not subscribe to Distinctive Ring
If the printer is sharing the line with other devices, then set the printer to pick up on the greater number of rings. If the
printer is connected to a dedicated fax line, then you can choose any number of rings that you want.

1 From the printer control panel, navigate to:

 > Fax Setup > Ringing and Answering > Pick Up On

2 Select the number of rings that you want, and then touch Accept.

Step 6: Create a contact list

Using the printer control panel
1 From the home screen, navigate to:

 > Address Book

2 Use the menus to add a contact or a fax group. You can add up to 89 contacts and 10 fax groups.

Note: In some models, entries 1–89 are for individual contacts and entries 90–99 are for fax groups. Enter the entry
number before entering the contact name and fax number of the contact.

Using the fax software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Fax tab > Edit contact list

The Contacts tab of the Printer Setup Utility opens.

4 Click Select from phonebook > select your phone book.

5 Select the contact that you want to add, and then click Add to or change list to import the contact.

Note: To add contacts, you need to import contacts from the phone books on your computer that are supported
by the fax software. In addition to the software Address Book, you may also have phone books of the mail clients
installed on your computer, such as Microsoft Outlook.

6 Click OK.

For Macintosh users

1 From the Finder, navigate to:

Applications > select your printer folder

2 Double-click Printer Settings.
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3 Click the Contacts tab.

• To add contacts, click the Individuals tab.

• To add fax groups, click the Groups tab.

4 Click  to open the Address Book.

Note: To add contacts, you need to import contacts from the Address Book on your Macintosh computer. If the
contact is not in the Mac Address Book, then first add the contact to the address book, and then import it.

5 From the Address Book, click and drag the contacts that you want to add to the Contacts list.

For more information, click Help or ?  to view the help information for the fax software.
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Ordering and replacing supplies

Ordering ink cartridges
Page yields available at www.lexmark.com/pageyields. For best results, use only Lexmark ink cartridges.

Lexmark S800 Series models

Item Return Program Cartridge1 Regular cartridge2

Black cartridge 100 100A

High yield black cartridge 100XL 100XLA

Yellow color cartridge 100 100A

High yield yellow color cartridge 100XL 100XLA

Cyan color cartridge 100 100A

High yield cyan color cartridge 100XL 100XLA

Magenta color cartridge 100 100A

High yield magenta color cartridge 100XL 100XLA

1 Licensed for a single use only. After use, return this cartridge to Lexmark for remanufacturing, refilling, or recycling.
2 Available only on the Lexmark Web site at www.lexmark.com.

Replacing ink cartridges
Make sure you have a new ink cartridge or cartridges before you begin. You must install new cartridges immediately
after removing the old ones, or the ink remaining in the printhead nozzles may dry out.

1 Turn on your printer.

2 Open the printer.

Note: The printhead moves to the cartridge installation position.
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3 Press the release tab, and then remove the used ink cartridge or cartridges.

1 2

4 Remove the ink cartridge from the pack, and then remove the protective cap from the ink cartridge.

If your ink cartridge comes with a muzzle cap, then remove the cap.

If your ink cartridge comes with a twist cap, then twist and remove the cap.

5 Install each ink cartridge. Use two hands to install the black cartridge.

Note: Install the new ink cartridges immediately after removing the protective cap to avoid exposing the ink to air.

6 Close the printer.
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Maintaining ink cartridges
In addition to the following tasks that you can perform, your printer performs an automatic maintenance cycle every
week if it is plugged into an electrical outlet. It will briefly come out of Power Saver mode or will temporarily turn on
if it is turned off.

Aligning the printhead
If the characters or lines on your printer image appear jagged or wavy, then you may need to align the printhead.

Using the printer control panel

1 Load plain paper.

2 From the home screen, navigate to:

 > More Options > Align Printer

An alignment page prints.

Note: Do not remove the alignment page until printing is finished.

Using the printer software (Windows only)

1 Load plain paper.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > Maintenance tab > Align cartridges

5 Follow the instructions on the computer screen.

If you aligned the cartridges to improve print quality, then print your document again. If print quality has not improved,
then clean the printhead nozzles.

Cleaning the printhead nozzles
Poor print quality is sometimes due to clogged printhead nozzles. Clean the printhead nozzles to improve the quality
of your prints.

Notes:

• Cleaning the printhead nozzles uses ink, so clean them only when necessary.

• Deep cleaning uses more ink, so try the Clean Printhead option first to save ink.

• If the ink levels are too low, then you must replace the ink cartridges before you can clean the printhead nozzles.

Using the printer control panel

From the home screen, navigate to:

 > More Options > Clean Printhead or Deep Clean Printhead

A cleaning page prints.
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Using the printer software (Windows only)

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Maintenance tab > Clean cartridges

4 Follow the instructions on the computer screen.
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Using the printer software

Minimum system requirements
The printer software requires up to 500MB of free disk space.

Supported operating systems
• Microsoft Windows 7

• Microsoft Windows Vista (SP2)

• Microsoft Windows XP (SP3)

• Macintosh Intel OS X version 10.6.0 or later

• Macintosh Intel OS X version 10.5.0 or later

• Macintosh Intel OS X version 10.4.4 or later

• Macintosh PowerPC OS X version 10.5.0 or later

• Macintosh PowerPC OS X version 10.4.0 or later

• Linux Ubuntu 10.04, 9.10, and 9.04*

• Linux OpenSUSE 11.3 and 11.2*

• Linux Fedora 12 and 11*

* The printer driver for this operating system is available only at http://support.lexmark.com.

Installing the printer software
Note: If you installed the printer software on this computer before but need to reinstall the software, then uninstall
the current software first.

For Windows users
1 Close all open software programs.

2 Insert the installation software CD.

If the Welcome screen does not appear after a minute, then launch the CD manually:

a Click , or click Start and then click Run.

b In the Start Search or Run box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

3 Follow the instructions on the Welcome screen.

For Macintosh users
1 Close all open software applications.

2 Insert the installation software CD.

If the installation dialog does not appear after a minute, then click the CD icon on the desktop.
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3 Double-click Install.

4 Follow the instructions on the installation dialog.

Using the Internet
1 Go to the Lexmark Web site at www.lexmark.com.

2 Navigate to:

Downloads > Driver Finder > select your printer > select your operating system

3 Download the driver and install the printer software.

Note: Updated printer software may be available at http://support.lexmark.com.

Using the Windows printer software

Software installed during printer installation
When you set up the printer using the installation software CD, all the necessary software was installed. You may have
chosen to install some additional programs. The following table provides an overview of various software programs
and what they can help you do.

If you did not install these additional programs during initial installation, then reinsert the installation software CD, run
the installation software, and then select Install Additional Software from the Software Already Installed screen.

Printer software

Use the To

LexmarkTM Printer Home

(referred to as Printer Home)

• Launch applications or programs.

• Access the Fax Solutions software.

• Scan or e-mail a photo or document.

• Edit scanned documents.

• Scan documents to PDF.

• Adjust settings for the printer.

• Order supplies.

• Maintain ink cartridges.

• Print a test page.

• Register the printer.

• Contact technical support.

Lexmark EzPrint

(referred to as EzPrint)

Manage, edit, transfer, and print photos and documents.

Lexmark Toolbar

(referred to as Toolbar)
• Print black or text-only Web pages to save ink.

• Schedule automatic printing of Web pages.

• Access Picnik and edit photos online.

• Print, scan, or convert local files from Windows.
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Use the To

Lexmark Tools for Office

(referred to as Tools for Office)

Access your favorite settings in Microsoft Office 2007.

Lexmark Fax Solutions

(referred to as Fax Solutions)
• Send a fax.

• Receive a fax in three-in-one printers.

• Add, edit, or delete contacts in the built-in phone book.

• Access the Lexmark Printer Setup Utility in four-in-one printers. Use the Printer
Setup Utility to set the Speed Dial and Group Dial numbers, set Ringing and
Answering, and print fax history and status reports.

Abbyy Sprint OCR Scan a document and produce text that you can edit with a word-processing
program.

Lexmark Wireless Setup Utility

(referred to as Wireless Setup Utility)
• Set up the wireless printer on a wireless network.

• Change the wireless settings of the printer.

Note: This program is installed automatically with the printer software if the
printer has wireless capability.

Lexmark Service Center

(referred to as Service Center)
• Troubleshoot the printer.

• Access the printer maintenance functions.

• Contact technical support.

Notes:

• This program is installed automatically with the printer software.

• You may be prompted to install this program from the Web, depending on
your printer model.

Printing Preferences When you click File > Print > Properties with a document open, a Printing
Preferences dialog appears. The dialog lets you select options for the print job,
such as the following:

• Select the number of copies to print.

• Print two-sided copies.

• Select the paper type.

• Add a watermark.

• Enhance images.

• Save settings.

Note: Printing Preferences is installed automatically with the printer software.

Note: Your printer may not come with some of these programs or some of the functions of these programs, depending
on the features of the printer that you purchased.
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Using the Macintosh printer software

Software installed during printer installation

Software resident in the Mac OS

Use the To

Print dialog Adjust the print settings and schedule print jobs.

Printer software

Applications are installed along with the printer software during installation.

1 From the Finder, navigate to:

Applications > select your printer folder

2 Double-click the application that you want to use.

Use the To

Scan Center • Scan photos and documents.

• Customize settings for scan jobs.

Printer Settings • Customize settings for fax jobs.

• Create and edit the Contacts list.

Network Card Reader • View the contents of a memory device inserted into a network printer.

• Transfer photos and PDF documents from a memory device to the computer over a network.

Wireless Setup Assistant Set up the printer on a wireless network.

Note: This application is automatically installed with the printer software if the printer has wireless
capability.

Uninstaller Remove the printer software from your computer.

Note: Your printer may not come with these applications, depending on the features of the printer that you purchased.

Web Links
Web Links are links to predefined Web pages. Web Links are saved in the printer folder.

1 From the Finder, navigate to:

Applications > select your printer folder > Web Links

2 Double-click the Web Link that you want to visit.

Use To

Customer Support Contact technical support.

Lexmark Software Updates Download and install the latest printer software.

Lexmark Online Visit the Lexmark Web site.

Order Supplies Online Order ink or supplies.
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Use To

Printer Registration Register your printer.

Visit Lexmark SmartSolutions • Visit the SmartSolutions Web site.

• Choose your custom solutions.

Note: Your printer may not come with these Web Links, depending on the features of the printer that you purchased.
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Printing

Printing a document

For Windows users
1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Select the print quality, the number of copies to print, the type of paper to use, and how the pages should print.

4 Click OK to close any printer software dialogs.

5 Click OK or Print.

For Macintosh users
1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop-up menu, choose your printer.

6 From the print options menu, choose the print quality, the number of copies to print, the type of paper to use, and
how the pages should print.

7 Click Print.

Printing on both sides of the paper (duplexing) automatically
The automatic duplex unit, available only on select printer models, supports letter- and A4-size paper. If you purchased
a model without automatic duplex, or if you need to print duplex using other paper sizes, then see the instructions for
printing on both sides of the paper (duplexing) manually.

For Windows users
1 With a document open, click File > Print.

2 Click Properties, Preferences, Options, or Setup.

3 Navigate to:

Advanced tab > 2-Sided Printing area > select On

Note: To use the settings defined in the printer, select Use Printer Settings.

4 Select either the Side Flip or Top Flip option. Side Flip is the setting most often used.
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5 Click OK to close any printer software dialogs.

6 Click OK or Print.

To return to single-sided printing, navigate to:

Advanced tab > 2-Sided Printing area > select Off

For Macintosh users
1 With a document open, choose File > Page Setup.

2 From the Page Setup dialog, set the printer, paper size, and orientation.

3 Click OK.

4 From the menu bar, choose File > Print.

5 From the Printer pop-up menu, choose your printer.

6 From the print options pop-up menu, choose Quality & Media.

7 From the Paper Type pop-up menu, choose Plain Paper.

8 From the print options pop-up menu, choose Layout.

9 From the Two-Sided pop-up menu, choose Long-Edge binding or Short-Edge binding.

• For Long-Edge binding, pages are bound along the long edge of the page (left edge for portrait, top edge for
landscape).

Portrait Landscape

1
2

1
2

• For Short-Edge binding, pages are bound along the short edge of the page (top edge for portrait, left edge for
landscape).

Portrait Landscape

10 Click Print.
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Printing photos using the printer control panel
1 Load photo paper.

2 Insert a memory card, flash drive, or digital camera set to mass storage mode.

The Memory Device screen appears on the display.

3 Touch View Photos.

The Select Photos screen appears.

4 Touch the photo or photos you want to print.

Tips:
• If you want to clear a selected photo, then touch the photo again.

• If you want to view more photos, then touch the left or right arrow, and then touch the photo to select it.

5 When you are finished selecting the photos you want to print, touch Layout.

6 If you want to change the print settings, then touch Change Settings.

If necessary, touch Accept each time you make a selection.

7 Press .

Note: For best results, allow the prints to dry at least 24 hours before stacking, displaying, or storing.
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Copying

Scanner glass

Load documents or photos facedown on the scanner glass. Use the scanner clip when loading small media on the scanner
glass.

Tips for copying
• When using the scanner glass, close the scanner lid to avoid dark edges on the scanned image.

• Look for the placement corner located on the lower right side of the scanner glass. This serves as a guide for proper
document placement.

• To capture an instant preview scan, put the document or photo on the scanner glass and close the scanner lid.

• To maximize scanning capacity of the printer, use the scanner clip found in the upper part of the glass to keep
photos, cards, or other small media in place.

Making copies
1 Load the original document.

The Instant Preview home screen appears.

Preview
A

Note: From the printer control panel, you can press  to print one copy of the original document using the default
settings.

Copying

57



2 Navigate to:

Copy > More Options > Number of Copies

3 Enter the number of copies you want to print, and then touch Accept.

4 Touch Color or Black/White to set a color or black-and-white copy.

5 Press .

Copying photos
1 Load photo paper.

2 Place a photo facedown on the scanner glass.

The Instant Preview home screen appears.

3 Navigate to:

SmartSolutions > Photo Reprint

4 Select the photo print size, and then touch Accept.

5 Touch Continue to start printing.

Note: For best results, allow the prints to dry at least 24 hours before stacking, displaying, or storing.

Making a duplex copy automatically
The automatic duplex unit, available only on select printer models, supports letter- and A4-size paper. If you purchased
a model without automatic duplex, or if you need to make duplex copies using other paper sizes, then see the
instructions for making a duplex copy manually.

Note: You cannot make duplex copies on envelopes, card stock, or photo paper.

1 Load the original document.

The Instant Preview home screen appears.

2 Navigate to:

Copy > More Options > 2-Sided Copies

3 Select a two-sided copying option, and then touch Accept.

• 1-Sided to 2-Sided—Make two-sided copies of the one-sided document.

• 2-Sided to 2-Sided—Make two-sided copies (like the original document).

4 Press  to save the first page of the document to the printer memory.

5 Follow the instructions on the display.
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Scanning

Scanner glass

Load documents or photos facedown on the scanner glass. Use the scanner clip when loading small media on the scanner
glass.

Tips for scanning
• When using the scanner glass, close the scanner lid to avoid dark edges on the scanned image.

• Look for the placement corner located on the lower right side of the scanner glass. This serves as a guide for proper
document placement.

• To capture an instant preview scan, put the document or photo on the scanner glass and close the scanner lid.

• Select the Multiple PDF file type if you want to scan multiple pages and save them as one file.

• To maximize scanning capacity of the printer, use the scanner clip found in the upper part of the glass to keep
photos, cards, or other small media in place.

• To initiate network scanning from the printer, make sure that “Enable network scan to computer” is selected in the
General tab of the Scan Center. This is available only in Mac OS X version 10.6.

Scanning to a local or network computer
1 Load the original document.

The Instant Preview screen appears.

Preview
A
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2 Navigate to:

Scan > Scan to: Destination > Scan to Computer

3 Touch USB-Connected Computer or the name of a network computer.

The local or network computer is the destination that will receive the scan.

Notes:

• If the printer is connected only to a local computer, then the printer will automatically set the local computer
as the default destination to receive the scan.

• For Macintosh users, if you want to scan from a network computer, then you must first add the printer to the
Edit Device List dialog. For more information, click Library > Printers > Lexmark > Utilities, open Edit Device
List, and then click ? .

• You may be prompted to enter a PIN if the computer requires it.

• To assign a computer name and a PIN to the computer, see the Help for the printer software associated with
your operating system.

4 Select the output file type you want to create, and then touch Accept.

5 Touch More Options to select the color, resolution quality, and the original image size. If necessary, touch
Accept each time you make a selection.

6 Press .

The scan is complete when a message appears on the printer control panel indicating that the file you scanned has
been saved.

Scanning to a flash drive or memory card
Before you begin, make sure your flash drive or memory card is not write-protected.

1 Load the original document.

The Instant Preview screen appears.

2 Navigate to:

Scan > Scan to: Destination

3 Insert the flash drive or memory card.

Notes:

• The printer reads only one memory device at a time.

• If a flash drive is inserted into the USB port while a memory card is in the card slot, then a message appears on
the display prompting you to select which memory device to use.

4 Select the output file type you want to create.

Note: Select the Multiple PDF file type if you want to scan multiple pages and save them as one file.

5 Touch More Options to select the color, resolution quality, and original image size. If necessary, touch Accept each
time you make a selection.

6 Press .

The scan is complete when a message appears on the printer control panel indicating that the file you scanned has
been saved.
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Scanning directly to e-mail using the printer software

For Windows users
1 Load an original document.

The Instant Preview screen appears.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > E-mail

5 Select Photo, Document, or PDF.

Note: You can select Document only if an OCR application is stored on your computer.

6 Scanning starts and the scan progress dialog appears.

7 When the scan is finished, a new e-mail message is created with the scanned document automatically attached.

8 Compose your e-mail message.

Note: If your e-mail program does not open automatically, then you can scan the document to the computer and then
send it through e-mail as an attachment.

For Macintosh users
1 Load an original document.

The Instant Preview screen appears.

2 From the Finder, navigate to:

Applications > select your printer folder

3 Double-click Scan Center.

If scanning from a network printer, then you must first add the printer to the Edit Device List dialog.

a From the Device pop-up menu, choose Browse Devices.

b From the Edit Device List dialog, add your printer. For more information, click ? .

c Click OK.

4 From the “What is being scanned?” area of the Scan Center, select a document type.

5 From the “How will the scanned image be used?” menu, choose To be viewed on monitor/Web page.

6 From the “Send scanned image to” menu, choose an application.

7 Click Scan.

8 Retrieve the scanned image from the application, and then send it through e-mail as an attachment.
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Scanning to a PDF

For Windows users
1 Load an original document.

The Instant Preview screen appears.

2 Click  or Start.

3 Click All Programs or Programs, and then select the printer program folder from the list.

4 Navigate to:

Printer Home > select your printer > PDF

Scanning starts and the scan progress dialog appears.

5 Save the document as a PDF.

For Macintosh users
1 Load an original document.

The Instant Preview screen appears.

2 From the Finder, navigate to:

Applications > select your printer folder

3 Double-click Scan Center.

If scanning from a network printer, then you must first add the printer to the Edit Device List dialog.

a From the Device pop-up menu, choose Browse Devices.

b From the Edit Device List dialog, add your printer. For more information, click ? .

c Click OK.

4 From the “What is being scanned?” area of the Scan Center, choose a document type.

5 Customize the settings as needed.

6 Click Scan.

7 Save the document as a PDF.
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E-mailing

Tips for e-mailing
• When using the scanner glass, close the scanner lid to avoid dark edges on the scanned image.

• Look for the placement corner located on the lower right side of the scanner glass. This serves as a guide for proper
document placement.

• To capture an instant preview scan, put the document or photo on the scanner glass and close the scanner lid.

• To maximize scanning capacity of the printer, use the scanner clip found in the upper part of the glass to keep
photos, cards, or other small media in place.

• Make sure to enter your e-mail account information and set up the SMTP server before sending an e-mail.

• Make sure the printer is connected to a wireless network before sending an e-mail.

If necessary, make sure the network is connected to the Internet for the printer to communicate with the SMTP
server. If the printer cannot connect to the Internet, then contact your system support person.

• Add contacts to your address book. When sending an e-mail, you can just select contacts from your address book
instead of typing their e-mail addresses repeatedly.

Scanning a document or photo to e-mail
1 Load the original document or photo.

The Instant Preview screen appears.

Preview
A

Note: You can attach only one file to each e-mail.

2 Navigate to:

Scan > Scan to: Destination > Scan to E-mail

3 Select the output file type you want to create.

Note: Select the Multipage PDF file type if you want to scan multiple pages and save them as one file.

4 Touch an option to enter or select the recipients:

• Enter E-mail Address—Enter the e-mail address manually.

• Address Book—Touch Sort by Name or Sort by Group, and then select the contact.

• History—Select the name or e-mail address from the history list.

If necessary, touch OK or Accept each time you make a selection.
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5 To enter additional recipients, touch Add Recipient, and then enter the e-mail address, name, or group you want
to add.

Touch Accept every time you add a recipient.

Note: You can send an e-mail to up to 30 recipients.

6 Select the file type, color, quality, and original size of the document or photo you want to send. If necessary, touch
Accept to save each setting.

7 If you want to change the default e-mail subject, then navigate to:

Subject > enter your subject > OK

8 If you want to change the default e-mail message, then navigate to:

Message > enter you message > OK

9 Press .

Attaching a document or photo to e-mail
1 Insert the flash drive or memory card.

The Memory Device screen appears on the display.

Notes:

• The printer reads only one memory device at a time.

• If a flash drive is inserted into the USB port while a memory card is in the card slot, then a message appears on
the display prompting you to select which memory device to use.

2 Touch Attach File to E-mail.

3 If you want to change the default e-mail subject, then navigate to:

Subject > enter your subject > OK

4 If you want to change the default e-mail message, then navigate to:

Message > enter your message > OK

5 Select the file to attach:

Note: You can attach only one document or photo to each e-mail.

• If you want to attach a document, then navigate to:
Attach document to E-mail > select the file name of the document > Continue

• If you want to attach a photo, then navigate to:
Attach Photo to E-mail > select a photo > Continue

6 Touch an option to enter or select the recipients:

• Enter E-mail Address—Enter the e-mail address manually.

• Address Book—Touch Sort by Name or Sort by Group, and then select the contact.

• History—Select the name or e-mail address from the history list.

If necessary, touch OK or Accept each time you make a selection.
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7 To enter additional recipients, touch Add Recipient, and then enter the e-mail address, name, or group you want
to add.

Touch Accept every time you add a recipient.

Note: You can send an e-mail to up to 30 recipients.

8 Touch Send.
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Faxing
CAUTION—SHOCK HAZARD: Do not use the fax feature during a lightning storm. Do not set up this product or
make any electrical or cabling connections, such as the power supply cord or telephone, during a lightning storm.

Sending faxes

Tips for sending faxes
Before you send a fax:

• Make sure that the printer is on and connected to a working telephone, DSL, or VoIP line. The line is working if you
hear a dial tone.

• When using the scanner glass, close the scanner lid to avoid dark edges on the scanned image.

• Look for the placement corner located on the lower right side of the scanner glass. This serves as a guide for proper
document placement.

• To capture an instant preview scan, put the document or photo on the scanner glass and close the scanner lid.

• To maximize scanning capacity of the printer, use the scanner clip found in the upper part of the glass to keep
photos, cards, or other small media in place.

Sending faxes using the printer control panel
1 Load an original document.

The Instant Preview home screen appears.

Preview
A

2 Touch Fax.

3 Send the fax:

To send a fax to a single recipient:
a Enter a fax number, or touch Address Book or History to import a contact.

b Touch .
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To send a fax to multiple recipients (broadcast fax):
a Touch Fax to Multiple, and then touch Add a Number.

b Enter a fax number, or touch Address Book or History to import a contact. Repeat this step until you have
entered the numbers of all the recipients.
Touch Accept every time you add a recipient.

c Touch .

Warning—Potential Damage: Do not touch the cables or the  and  ports while sending a fax.

Tip:
• You can broadcast a fax to up to 30 recipients.

• Touch More Options to set a color or black-and-white fax, adjust the quality of the fax, set the size of the document,
add a cover page, schedule the fax, or view pending faxes.

Sending faxes using the fax software

For Windows users

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer program folder from the list.

3 Navigate to:

Printer Home > select your printer > Fax tab > Send a fax

4 Click Send a new fax.

The Send Fax Wizard opens.

5 Follow the instructions on the computer screen.

For Macintosh users

1 With a document open, choose File > Print.

2 From the Printer pop-up menu, select the fax version of your printer.

Note: In order to see the fax options on the Print dialog, you must use the fax driver for your printer. If the fax
version of the printer is not on the list, choose Add a printer, and then choose the fax version of the printer.

3 Enter the name and number of the recipient.

4 Click Fax.
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Receiving faxes

Tips for receiving faxes
When receiving faxes:

• Make sure that the printer is on and connected to a working telephone, DSL, or VoIP line. The line is working if you
hear a dial tone.

• If you set the printer to receive faxes manually (Auto Answer Off), then make sure that the ringer volume is not set
to Off.

• If you have set the printer to receive faxes automatically (Auto Answer On), then load paper in the printer.

Receiving faxes automatically
1 Make sure that Auto Answer is on:

a From the home screen, navigate to:

 > Fax Setup > Ringing and Answering > Auto Answer

b If Auto Answer is not set to On, touch On, and then touch Accept.

2 Set the number of rings before the printer picks up incoming faxes:

a Touch Pick Up On.

b Set the number of rings, and then touch Accept to save the setting.
When the number of rings you set is detected, the printer automatically receives the incoming fax.

Warning—Potential Damage: Do not touch the cables or the  and  ports while receiving a fax.

Tips:
• If the printer is sharing the line with other analog devices (telephone, answering machine), then set the printer to

pick up calls two rings after the answering machine. For example, if the answering machine picks up calls after four
rings, then set the printer to pick up after six rings. This way, the answering machine picks up calls first and your
voice calls are received. If the call is a fax, then the printer detects the fax signal on the line and takes over the call.
If the printer is on a dedicated fax line, then you may set the printer to pick up on any number of rings.

• If you have multiple numbers on a single line, or if you subscribe to a distinctive ring service provided by your
telephone company, then make sure that you set the correct ring pattern for the printer. Otherwise, the printer
will not receive faxes even if you have set it to receive faxes automatically.

Receiving faxes manually
1 Make sure that Auto Answer is off:

a From the home screen, navigate to:

 > Fax Setup > Ringing and Answering > Auto Answer

b If Auto Answer is not set to Off, touch Off, and then touch Accept.

Faxing

68



2 When the telephone rings and you hear fax tones when you pick up the handset, press  on the printer or *9* on
the telephone attached to the printer.

Note: The default code for answering faxes manually is *9*, but for increased security, you can change it to a
number that only you know. You can enter up to 7 characters for your code. The valid characters are the digits 0–
9 and the characters # and *.

Warning—Potential Damage: Do not touch the cables or the  and  ports while actively receiving a fax.
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Using SmartSolutions

What is SmartSolutions?
SmartSolutions is a set of solutions that you can create, customize, and download from the SmartSolutions Web site
(http://smartsolutions.lexmark.com) to your printer. It lets you create one-touch custom solutions to streamline
repetitive copying, scanning, and printing tasks. SmartSolutions also lets you view RSS feeds, Google Calendar, news
headlines, and online photo albums, among others, from the printer control panel.

To access a solution you created or customized, touch SmartSolutions on the printer control panel, and then select the
icon or name of the solution.

The following are some of the solutions that may be available; be sure to check the SmartSolutions Web site for an
updated list.

Preloaded solutions

Use To

ID Card Copy Copy both sides of an ID card onto a single page.

Photo Reprint Create photo reprints.

Tell Me More Learn more about SmartSolutions and how you can create and download your
custom solutions.

Custom solutions

Solution Description

A5 Copy

Legal Copy

Fit to Page Copy

Copy A5 or legal-sized documents from the Automatic Document Feeder, or
automatically resize your copy to fit an entire page with Fit to Page Copy solution.

Business Card Scan

(Windows only)

Scan up to 8 business cards at a time and synchronize with your current contact
management program to access each scanned card's information.

Cartridge Finder View information on local stores where you can purchase cartridges, with options
to print or e-mail cartridge and retailer information as well as print a map of the
retailer location.

Customizable Copy

Black & White Copy

Darker Copy

Copy documents or photos in black and white, in darker shade, or using custom
settings.

Duplex Copy Cut your paper consumption in half by copying two pages onto one duplex copy.

Eco-Copy Copy documents or photos using settings that have positive environmental impact.

Google Calendar* View your Google Calendar with an option to print the daily agenda or event details.

* You can select one of these solutions as your printer screen saver.
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Solution Description

MobileMe Photos*

Photo Viewer*

Photobucket Viewer*

Picasa Photo Viewer*

View photos from Web sites, such as MobileMe, Photobucket, and Picasa, with
options to print or send an e-mail with a link to the selected photo.

Print a File

(Windows only)

Preview & Copy

Use the printer to print or preview document files on your computer or external
storage device that were previously selected in the Solution Center.

RSS Headlines*

Apple Hot News*

MSNBC Headlines*

View news headlines, article summaries, and other feeds, with options to e-mail
the complete articles or launch them for viewing on a computer.

Scan to E-mail E-mail scanned documents directly from the printer using predefined names or
contacts from the address book.

Scan to Evernote Scan documents to your Evernote account, an online organizer for your photos,
documents, thoughts, and ideas.

Scan to Fax Fax documents directly from the printer using predefined names or contacts from
the address book.

Scan a Photo

Scan to File

Scan and save files or photos to a previously selected directory on a computer using
predefined settings.

Scan to PDF

(Windows and Macintosh only)

Scan and save documents in PDF format to your computer.

Stamps.com Shipping Purchase and print US Postal Service domestic shipping labels, with an option to
choose the type of envelope, the weight of your package, and the delivery method.

* You can select one of these solutions as your printer screen saver.

Examples:
• If you are a business owner or supervisor who frequently prints a work schedule, then you could create a Print a

File solution. Specify the location of your schedule file, and then name the solution Print Schedule. The next time
you need to print a copy of the current schedule, simply select Print Schedule from the SmartSolutions menu on
the printer control panel. The printer automatically finds the file and prints it.

• If you frequently scan and fax a document to your lawyer using the same settings, then you could create a Scan to
Fax solution and name it Fax to Lawyer. The next time you want to fax a document, you simply have to load the
document and select Fax to Lawyer from the SmartSolutions menu on the printer control panel. The printer
automatically applies your chosen settings, selects your lawyer as the fax recipient, and then sends the fax.

Note: You need to add your printer to the Solution Center before you can start creating or customizing solutions.

Creating and customizing printer solutions
Before you begin, make sure:

• Your printer and computer are each connected to the Internet through an Ethernet or wireless connection.

• Your printer is powered on.

1 Launch the SmartSolutions Web site:
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Using the printer software
a Open the printer program folder:

For Windows users
1 Click  or Start.
2 Click All Programs or Programs, and then select the printer program folder from the list.

For Macintosh users
1 From the Finder, navigate to:

Applications > select your printer folder
2 Double-click Web Links.

b Click Visit Lexmark SmartSolutions.

Using a Web browser
a Open a Web browser.

b Type smartsolutions.lexmark.com in the address bar, and then press Enter.

2 From the SmartSolutions Web site, log in or create an account.

3 Add your printer.

4 Use the Web site to create, customize, and download solutions to your printer.

For more information, see the SmartSolutions User's Guide on the Web site.
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Troubleshooting

Before you troubleshoot
Use this checklist to solve most printer problems:

• Make sure the power cord is plugged into the printer and into a properly grounded electrical outlet.

• Make sure the printer is turned on.

• Make sure the printer is securely connected to the host computer, print server, or other network access point.

• Check the printer for error messages, and resolve any errors.

• Check for paper jam messages, and clear any jams.

• Check the ink cartridges, and install new cartridges if necessary.

• Turn the printer off, wait about 10 seconds, and then turn the printer back on.

Note: Make sure the printer is not in Power Saver mode. Press and hold  for three seconds to turn off the printer.

• Use the Service Center to locate and solve the problem (Windows only).

Using the Service Center to solve printer problems
The Service Center provides step-by-step troubleshooting help and contains links to printer maintenance tasks and
customer support.

To open the Service Center, use one of these methods:

Method 1 Method 2

If it appears on an error message dialog, then click the For
additional assistance, use the Service Center link.

1 Click  or Start.

2 Click All Programs or Programs, and then select the printer
program folder from the list.

3 Navigate to:

Printer Home > Support tab > Service Center

If Troubleshooting does not solve your problem
Visit our Web site at http://support.lexmark.com to find the following:

• Knowledgebase articles with the latest information and troubleshooting for your printer

• Live online technical support

• Contact numbers for telephone technical support

Setup troubleshooting
• “Incorrect language appears on the display” on page 74

• “Printhead errors” on page 75

• “Software did not install” on page 76
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• “Print job does not print or is missing pages” on page 77

• “Printer is printing blank pages” on page 79

• “Printer is busy or does not respond” on page 79

• “Cannot delete documents from the print queue” on page 80

• “Cannot print through USB” on page 80

Welcome screen did not appear during installation
If the "Before you troubleshoot" checklist does not solve the problem, then try the following:

LAUNCH THE PRINTER CD MANUALLY

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type D:\setup.exe, where D is the letter of your CD or DVD drive.

3 Follow the instructions on the computer screen.

For Macintosh users

1 From the Finder desktop, click the CD icon.

2 Double-click Install.

3 Follow the instructions on computer screen.

Found New Hardware message appears

MAKE SURE THE USB CABLE IS NOT CONNECTED DURING HARDWARE INSTALLATION

During hardware installation, do not connect the USB cable. Connect only the power cord when instructed.

CLOSE ANY FOUND NEW HARDWARE SCREENS

Click Cancel on any Found New Hardware screens that appear during installation.

Incorrect language appears on the display
If the "Before you troubleshoot" checklist does not solve the problem, then try the following:

CHANGE THE LANGUAGE USING THE PRINTER MENUS

1 From the home screen, navigate to:

 > Device Setup > Language

2 Select a language, and then touch Accept.

3 Touch Yes to confirm this setting.
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Printhead errors
If the "Before you troubleshoot" checklist does not solve the problem, then try the following:

REMOVE AND REINSERT THE PRINTHEAD

1 Open the front door of the printer, and then open the printhead access door.

2 Pull the latch forward, and then remove the printhead.

3 Wipe the printhead contacts using a clean, lint-free cloth.

Warning—Potential Damage: Do not touch the printhead nozzles.
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4 Reinsert the printhead, and then push the latch until it clicks into place.

5 Close the printhead access door, and then close the front door.

Note: If removing and reinserting the printhead does not resolve the error, then contact customer support.

Software did not install
If you encountered problems while installing, or if your printer does not appear in the list in the printers folder or as a
printer option when sending a print job, then try removing and reinstalling the software.

Before you reinstall the software, do the following:

MAKE SURE THAT YOUR COMPUTER MEETS THE MINIMUM SYSTEM REQUIREMENTS

TEMPORARILY DISABLE SECURITY PROGRAMS IN WINDOWS BEFORE INSTALLING THE SOFTWARE

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.

3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.
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RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Power Saver mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

12

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

21

4 Turn on the printer.

Print job does not print or is missing pages
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

MAKE SURE THE INK CARTRIDGES ARE INSERTED CORRECTLY

1 Turn on the printer, and then open the front door of the printer.

2 Make sure the cartridges are inserted correctly.

The cartridges should click firmly into the matching color slot of the printhead.

3 Close the front door.

SELECT YOUR PRINTER FROM THE PRINT DIALOG BEFORE SENDING THE PRINT JOB

Note: This solution applies to Macintosh users only.

1 With a document open, choose File > Print.

2 From the printer pop-up menu, choose your printer, and then click Print.
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If your printer does not appear on the Printer list, then choose Add Printer. From the list of printers in the Default
tab, select your printer, and then click Add.

If your printer does not appear on the list, then try either of the following:

• For a USB-connected printer, remove and then reconnect the USB cable.

• For a printer that is wirelessly connected, see the Wireless troubleshooting section.

MAKE SURE THE PRINT JOB IS NOT PAUSED

MAKE SURE YOUR PRINTER IS SET AS THE DEFAULT PRINTER

RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Power Saver mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

12

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

21

4 Turn on the printer.

REMOVE AND RECONNECT THE USB CABLE CONNECTED TO YOUR PRINTER

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.
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3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.

REMOVE AND REINSTALL THE PRINTER SOFTWARE

Printer is printing blank pages
Blank pages may be caused by improperly installed ink cartridges.

REINSTALL THE INK CARTRIDGES AND DEEP CLEAN AND ALIGN THE PRINTHEAD

1 Reinstall the ink cartridges. For more information, see “Replacing ink cartridges” on page 45.

If the cartridges do not seem to fit, then make sure the printhead is properly seated, and then try installing the
cartridges again.

2 Load plain paper.

3 From the home screen, navigate to:

 > More Options > Deep Clean Printhead

A cleaning page prints.

4 Navigate to:

 > More Options > Align Printer

An alignment page prints.

Note: Do not remove the alignment page until printing is finished.

Printer is busy or does not respond
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

MAKE SURE THE PRINTER IS NOT IN POWER SAVER MODE

If the power light is blinking on and off slowly, then the printer is in Power Saver mode. Press  to wake up the
printer.

If the printer will not come out of Power Saver mode, then reset the power:

1 Unplug the power cord from the wall outlet, and then wait 10 seconds.

2 Insert the power cord into the wall outlet, and then turn on the printer.

If this problem persists, then check our Web site for updates for your printer software or firmware.
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RECONNECT THE PRINTER POWER SUPPLY

1 Turn off the printer.

Note: Make sure the printer is not in Power Saver mode. Press and hold  for three seconds to turn off the printer.

2 Unplug the power cord from the wall outlet, and then pull out the power cord from the power supply.

12

3 After one minute, reconnect the power cord into the power supply, and then plug the power cord into the wall
outlet.

21

4 Turn on the printer.

Cannot delete documents from the print queue
If you have jobs stuck in the print queue and cannot delete them to get other jobs to print, then the computer and
printer may not be communicating.

RESTART THE COMPUTER AND TRY AGAIN

REMOVE AND RECONNECT THE USB CABLE CONNECTED TO YOUR PRINTER

Cannot print through USB
If the "Before you troubleshoot" checklist does not solve the problem, then try one or more of the following:

CHECK THE USB CONNECTION

1 Check the USB cable for any obvious damage. If the cable is damaged, then use a new one.

2 Firmly plug the square end of the USB cable into the back of the printer.
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3 Firmly plug the rectangular end of the USB cable into the USB port of the computer.

The USB port is marked with .

Note: If you continue to have problems, then try another USB port on the computer. You may have connected to a
defective port.

MAKE SURE THE USB PORT IS ENABLED IN WINDOWS

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type devmgmt.msc.

3 Press Enter, or click OK.

The Device Manager opens.

4 Click the plus sign (+) beside Universal Serial Bus controllers.

If USB Host Controller and USB Root Hub are listed, then the USB port is enabled.

For more information, see the computer documentation.

REMOVE AND REINSTALL THE PRINTER SOFTWARE

Wireless troubleshooting

Wireless troubleshooting checklist
Before beginning to troubleshoot the wireless printer, verify the following:

• The printer, the computer, and the access point (wireless router) are all plugged in and turned on.

• The wireless network is working properly.

Try accessing other computers on your wireless network.

If your network has Internet access, then try connecting to the Internet over a wireless connection.

• Your SSID is correct.

Print a network setup page to verify the SSID the printer is using.

If you are not sure if your SSID is correct, then run the wireless setup again.

• Your WEP key or WPA passphrase is correct (if your network is secure).

Log on to the access point and check the security settings.

A security key is like a password. All devices on the same wireless network using WEP, WPA, or WPA2 share the
same security key.

If you are not sure if your security information is correct, then run the wireless setup again.

• The printer and the computer are within the range of the wireless network.

For most networks, the printer and the computer should be within 100 feet (30 meters) of the access point (wireless
router).

• The Wi-Fi indicator is green and successfully connected.

• The printer driver is installed on the computer from which you are performing a task.

• The correct printer port is selected.
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• The computer and printer are both connected to the same wireless network.

• The printer is located away from obstacles or electronic devices that could interfere with the wireless signal.

Make sure the printer and access point are not separated by poles, walls, or support columns containing metal or
concrete.

Many devices can interfere with the wireless signal, including baby monitors, motors, cordless phones, security
system cameras, other wireless networks, and some Bluetooth devices.

Printing a network setup page
A network setup page lists the configuration settings of the printer, including the IP address and MAC address of the
printer.

1 Load plain paper.

2 From the home screen, navigate to:

 > Network Setup > Print Setup Page

Locating IP addresses

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type cmd.

3 Press Enter, or click OK.

The Command Prompt window opens.

4 Type ipconfig, and then press Enter.

The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.

For Macintosh users

1 From the Apple menu, choose About This Mac.

2 Click More Info.

3 From the Contents pane, choose Network.

4 If you are connected over a wireless network, choose AirPort from the Active Services list.

Locating the printer IP address
• You can locate the printer IP address by viewing the printer network setup page. See the User's Guide on the software

installation CD for more information on printing a network setup page.
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Cannot print over wireless network
If you encountered problems while installing, or if your printer does not appear in the printers folder or as a printer
option when sending a print job, then you can try uninstalling and reinstalling the software.

Before you reinstall the software, check the troubleshooting checklist, and then do the following:

TURN THE ACCESS POINT (WIRELESS ROUTER) OFF AND THEN BACK ON

Wait one minute for the printer and computer to reestablish the connection. This can sometimes refresh network
connections and resolve connectivity issues.

DISCONNECT FROM VPN SESSION

When you are connected to another network through a VPN connection, you will not be able to access the printer
over your wireless network. End your VPN session and try printing again.

MAKE SURE DEMO MODE IS TURNED OFF

Select printer features are not available when Demo Mode is turned on.

From the home screen, navigate to:

 > Demo Mode > Off > save the setting

CHECK YOUR WEP KEY OR WPA PASSPHRASE

If your access point is using WEP security, then the WEP key should be:

• Exactly 10 or 26 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• Exactly 5 or 13 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII
characters in a WEP key are case-sensitive.

If your access point is using WPA or WPA2 security, then the WPA passphrase should be:

• Exactly 64 hexadecimal characters. Hexadecimal characters are A–F, a–f, and 0–9.

or

• From 8 to 63 ASCII characters. ASCII characters are letters, numbers, and symbols found on a keyboard. ASCII
characters in a WPA passphrase are case-sensitive.

Note: If you do not know this information, then see the documentation that came with the wireless network, or
contact the person who set up your wireless network.

CHECK IF YOUR ACCESS POINT HAS AN ASSOCIATION/REGISTRATION BUTTON

Wireless broadband boxes in Europe, the Middle East, and Africa such as LiveBox, AliceBox, N9UF Box, FreeBox, or
Club Internet may require you to press an association/registration button when adding the printer to your wireless
network.

If you are using one of these boxes and need more information, then see the documentation that came with your
box, or contact your Internet Service Provider (ISP).
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MOVE YOUR ACCESS POINT AWAY FROM OTHER ELECTRONIC DEVICES

There may be temporary interference from electronic devices such as microwave ovens or other appliances, cordless
phones, baby monitors, and security system cameras. Make sure your access point is not positioned too closely to
these devices.

MOVE THE COMPUTER AND/OR PRINTER CLOSER TO THE ACCESS POINT

The range of your wireless network depends on many factors, including the abilities of your access point and network
adapters. If you are having trouble printing, then try placing the computer and printer no more than 100 feet apart.

CHECK THE WIRELESS SIGNAL QUALITY

Print a network setup page and check the signal quality. If the signal quality is listed as good or excellent, then another
factor is causing the problem.

CHECK YOUR ADVANCED SECURITY SETTINGS

• If you are using MAC (Media Access Control) address filtering to limit access to your wireless network, then you
must add the printer MAC address to the list of addresses allowed to connect to the access point.

• If you set the access point to issue a limited number of IP addresses, then you must change this so that the printer
can be added.

Note: If you do not know how to make these changes, then see the documentation that came with the access point,
or contact the person who set up your wireless network.

MAKE SURE YOUR COMPUTER IS CONNECTED TO YOUR ACCESS POINT

• See if you have access to the Internet by opening your Web browser and accessing any site.

• If there are other computers or resources on your wireless network, then check to see if you can access them
from your computer.

MAKE SURE THAT YOUR COMPUTER AND PRINTER ARE CONNECTED TO THE SAME WIRELESS NETWORK

If the printer is not on the same wireless network as the computer, then you will not be able to print wirelessly. The
SSID of the printer must match the SSID of the computer, if the computer is already connected to the wireless network.

For Windows users

1 Obtain the SSID of the network that the computer is connected to.

a Type the IP address of your access point into the address field of your Web browser.

If you do not know the IP address of the access point:

1 Click , or click Start and then click Run.
2 In the Start Search or Run box, type cmd.

3 Press Enter or click OK.
4 Type ipconfig, and then press Enter. Check the Wireless Network Connection section:

• The “Default Gateway” entry is typically the access point .

• The IP address appears as four sets of numbers separated by periods, such as 192.168.2.134.

b Type the user name and password of the access point when prompted.

c Click OK.
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d In the Wireless settings section, look for the SSID.

e Write down the SSID.

Note: Make sure you copy it exactly, including any capital letters.

2 Obtain the SSID of the network that the printer is connected to:

a From the printer, print a network setup page.

b In the Wireless section, look for SSID.

3 Compare the SSID of the computer and SSID of the printer.

If the SSIDs are the same, then the computer and the printer are connected to the same wireless network.

If the SSIDs are not the same, then run the utility again to set up the printer on the wireless network used by the
computer.

For Macintosh users with an AirPort base station

In Mac OS X version 10.5 or later

1 From the Apple menu, navigate to:

System Preferences > Network > AirPort

The SSID of the network that the computer is connected to is displayed in the Network Name menu.

2 Write down the SSID.

In Mac OS X version 10.4 or earlier

1 From the Finder, navigate to:

Applications > Internet Connect > AirPort

The SSID of the network that the computer is connected to is displayed in the Network menu.

2 Write down the SSID.

For Macintosh users with an access point

1 Type the IP address of the access point in the address field of your Web browser, and then continue to step 2.

If you do not know the IP address of the access point, then do the following:

a From the Apple menu, navigate to:
System Preferences > Network > AirPort

b Click Advanced or Configure.

c Click TCP/IP.
The Router entry is typically the access point.

2 Type your user name and password when prompted, and then click OK.

3 In the Wireless settings section, look for the SSID.

4 Write down the SSID, security type, and the WEP key/WPA passphrase (if shown).

Notes:

• Make sure you copy the network information down exactly, including any capital letters.

• Store the SSID and the WEP key or WPA passphrase in a safe place for future reference.
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MAKE SURE YOUR OS IS COMPATIBLE WITH WIRELESS PRINTING THROUGH AIRPORT

The printer supports wireless printing only through AirPort base stations for Mac OS X version 10.5 or later.

“Communication not available” message displays when printing wirelessly
Try one or more of the following:

MAKE SURE YOUR COMPUTER AND PRINTER HAVE VALID IP ADDRESSES FOR THE NETWORK

If you are using a laptop and have power saving settings enabled, then you may see the ”Communication not available”
message on your computer screen when you attempt to print wirelessly. This can occur if the laptop hard drive has
powered down.

If you see this message, then wait a few seconds and then try to print again. The laptop and printer require a few
seconds to power up again and reattach to the wireless network.

If you see this message again after you have waited long enough for the printer and the laptop to attach to the
network, then there may be a problem with your wireless network.

Make sure that the laptop and printer have both received IP addresses:

For Windows users

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type cmd.

3 Press Enter, or click OK.

4 Type ipconfig, and then press Enter.

The IP address appears as four sets of numbers separated by periods, such as 192.168.0.100.

For Macintosh users

1 From the Apple menu, navigate to:

About This Mac > More Info

2 From the Contents pane, choose Network.

3 If you are connected over a wireless network, choose AirPort from the Active Services list.

The Router entry is typically the access point.

Locating the printer IP address
• From the printer, print a network setup page.

In the TCP/IP section, look for Address.

• View the printer settings.

1 From the printer control panel, navigate to:

 > Network Setup > TCP/IP

2 Look for IP Address.
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If the printer and/or the laptop does not have an IP address, or if either has an address of 169.254.x.y (where x and
y are any two numbers between 0 and 255):

1 Turn off the device that does not have a valid IP address (the laptop, the printer, or both).

2 Turn on the device(s), and then check the IP addresses again.

If the laptop and/or printer still does not receive a valid IP address, then there is a problem with your wireless network.
Try the following:

• Make sure your access point (wireless router) is turned on and is working.

• Remove any objects that could be blocking the signal.

• Temporarily turn off any unnecessary wireless devices on your network and pause any network-intensive
activities, like large file transfers or network games. If the network is too busy, then it is possible that the printer
is not receiving the IP address within the allowed time.

• Make sure your DHCP server, which may also be your wireless router, is working and is configured to assign IP
addresses. If you are not sure how to do this, then refer to the manual that came with your wireless router.

If the printer and computer have valid IP addresses and the network is operating correctly, then continue
troubleshooting.

MAKE SURE THE WIRELESS PORT IS SELECTED

Note: This solution applies to Windows users only

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

4 Right-click the printer, and then select Properties or Printer properties from the menu.

5 Click the Ports tab.

6 Locate the selected port. The selected port has a check beside it in the Port column.

7 If the Description column of the selected port indicates that it is a USB port, then scroll through the list and select
the port with Printer Port in the Description column. Check the printer model in the Printer column to make sure
you select the right printer port.

8 Click OK, and then try to print again.

MAKE SURE BIDIRECTIONAL COMMUNICATION IS ENABLED

Note: This solution applies to Windows users only

1 Click , or click Start and then click Run.

2 In the Start Search or Run box, type control printers.

3 Press Enter, or click OK.

4 Right-click the printer, and then select Properties or Printer properties from the menu.

5 Click the Ports tab.

6 Click the box next to Enable bidirectional support if it is not already checked.

7 Click Apply > OK, and then try to print again.
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Fax troubleshooting
• “Fax troubleshooting checklist” on page 88

• “Cannot send faxes” on page 88

• “Cannot receive faxes” on page 90

• “Cannot run the fax software” on page 91

Fax troubleshooting checklist
If you encounter problems sending and receiving faxes, then check the connection first:

1 Check for a dial tone on the telephone line by plugging an analog telephone into the wall jack, DSL filter, VoIP device,
or cable modem where you connected the printer. Make sure you plug the telephone into the same port.

If you do not hear a dial tone, then contact your line provider.

2 While the printer is connected to the telephone line, check for a dial tone by plugging an analog telephone into the
 port of the printer.

If you do not hear a dial tone, then use the checklist below. Listen for a dial tone after checking each item.

If you hear a dial tone but still have problems sending and receiving faxes, then see the other topics in this section.

Connection checklist
• Make sure that the printer and other devices on the line (if applicable) are set up and configured correctly according

to your setup scenario.

• Make sure that the cables are connected to the correct ports.

• Make sure that the cables are securely plugged in.

Check the cable connections for the following hardware, if applicable:

Power supply Answering machine Cable modem Splitter

Telephone VoIP adapter DSL filter RJ-11 adapter

• If the printer is connected to a Digital Subscriber Line, then make sure you are using a DSL filter for the printer.

• If the printer is connected to a VoIP adapter or cable modem, then make sure that the printer is plugged into the
first phone port.

• If you are using a splitter, then make sure that you are using a phone splitter. Do not use a line splitter.

Cannot send faxes
If the “Fax troubleshooting checklist” does not solve the problem, then try one or more of the following:

MAKE SURE TO ENTER YOUR USER INFORMATION IN THE PRINTER

If you did not enter your user information during initial setup, then enter your fax name and fax number. This is the
information that identifies you as the sender in all the faxes that you send. Some countries or regions require the
fax number and fax name for you to send a fax, and some fax machines block anonymous faxes.
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DECREASE THE TRANSMISSION SPEED OF THE FAX MODEM

The modem of the printer can transmit data at 33,600 bps. This is the maximum speed at which the printer can send
and receive faxes. It is not necessary, however, to set the modem to its fastest transmission capability. The speed of
the modem of the receiving fax machine must match or be greater than the speed at which you are sending your
fax. Otherwise, your fax will not be received.

1 From the home screen, navigate to:

 > Fax Setup > Dialing and Sending > Max Send Speed

2 Select a sending speed, and then touch Accept.

SET THE PRINTER TO SCAN THE ORIGINAL DOCUMENT BEFORE DIALING THE NUMBER

The printer does not automatically redial if you set it to scan the original document after dialing the number.

Set the printer to scan before dialing so that you do not have to scan the document again if the fax fails. The scanned
document is saved in the printer memory. The printer can then retrieve it and automatically redial the number.

1 From the home screen, navigate to:

 > Fax Setup > Dialing and Sending > Scan

2 Touch Before Dial, and then touch Accept.

ENABLE ERROR CORRECTION

Errors and blurs may appear in the faxed document if there is too much noise on the line. This feature enables the
printer to transmit the bad blocks of data again and correct the errors. When a fax has too many errors, the fax may
be rejected by the receiving fax machine.

1 From the home screen, navigate to:

 > Fax Setup > Dialing and Sending > Error Correction

2 Touch On, and then touch Accept.

ENABLE AUTOMATIC FAX CONVERSION

If the receiving fax machine does not support color fax, then this option automatically converts the outgoing color
fax to black and white. It also automatically reduces the resolution of the fax to a resolution that the receiving machine
can support.

1 From the home screen, navigate to:

 > Fax Setup > Dialing and Sending > Auto Fax Convert

2 Check to see if automatic fax conversion is set to On.

If it is not set to On, touch On, and then touch Accept.

MAKE SURE THAT THE DIAL PREFIX SETTING IS CORRECT

The dialing prefix is the number or series of numbers that you press before you can dial the actual fax number or
telephone number. If the printer is in an office setting or in a private branch exchange, this can be a specific number
that you need to press so you can make a call outside the office.
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Make sure that the dial prefix entered in the printer is correct for your network.

1 From the home screen, navigate to:

 > Fax Setup > Dialing and Sending > Dial Prefix

2 Check the prefix.

If the prefix is not correct, enter the correct prefix, and then touch Accept.

Cannot receive faxes
If the “Fax troubleshooting checklist” does not solve the problem, then try one or more of the following:

MAKE SURE THAT YOU HAVE CONFIGURED THE CORRECT SETTINGS FOR YOUR SETUP

If the printer is sharing the line with other devices, then make sure that the following are set:

• Auto Answer is on.

• The printer picks up on a greater number of rings than the other devices.

• The printer picks up on the correct distinctive ring, if you subscribe to a distinctive ring service.

MAKE SURE THAT THE PRINTER IS CONNECTED TO AN ANALOG PORT

The printer is an analog device. If you are using a PBX system, then make sure that the printer is connected to an
analog port on the PBX. You may need a digital line converter that converts digital signals into analog signals.

MAKE SURE TO FREE UP PRINTER MEMORY

The printer saves an incoming fax to the printer memory before it prints the fax. If the printer runs out of ink or runs
out of paper while receiving the fax, then the printer saves the fax so you can print it later. However, if the printer
memory is full, then the printer may not be able to receive more incoming faxes. An error message appears on the
touch screen when the printer memory is full. Resolve the error to free up space in the printer memory.

MAKE SURE THAT FAX FORWARDING IS DISABLED

1 From the home screen, navigate to:

 > Fax Setup > Ringing and Answering > Fax Forward

2 Touch Off, and then touch Accept.

INCREASE THE RINGER VOLUME

If you set the printer to receive faxes manually (Auto Answer Off), then increase the ringer volume.
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MAKE SURE THAT YOU HAVE THE CORRECT MANUAL ANSWER CODE

If you set the printer to receive faxes manually (Auto Answer Off), then you need to enter the correct code when a
fax comes in so that the printer can receive it.

1 From the home screen, navigate to:

 > Fax Setup > Ringing and Answering > Manual Answer Code

2 Copy the manual answer code that appears on the touch screen.

Note: The default code is *9*, but for increased security, you can change it to a number that only you know.

Cannot run the fax software
The printer must be connected to a telephone, DSL, VoIP, or cable service before you can configure the fax settings in
the fax software.

MAKE SURE THE FAX SOFTWARE IS INSTALLED

The Fax Solutions Software is optional for Windows users and is installed with the printer software only if you select
it on the “Install Additional Software” screen during installation. If you did not install the fax software, then the Fax
tab on the Printer Home takes you to our Web site where you can download the software.

MAKE SURE THE PRINTER IS CONNECTED TO A TELEPHONE LINE

You need to connect the printer to your telephone line through a standard wall jack (RJ-11), a DSL filter, a VoIP
adapter, or a cable modem before you can open the fax software and configure the fax settings.

MAKE SURE THAT THE PRINTER IS CONNECTED TO THE COMPUTER

MAKE SURE THAT THE PRINTER IS NOT IN POWER SAVER MODE
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Notices

Edition notice
November 2010

The following paragraph does not apply to any country where such provisions are inconsistent with local law:
LEXMARK INTERNATIONAL, INC., PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain
transactions; therefore, this statement may not apply to you.

This publication could include technical inaccuracies or typographical errors. Changes are periodically made to the
information herein; these changes will be incorporated in later editions. Improvements or changes in the products or
the programs described may be made at any time.

References in this publication to products, programs, or services do not imply that the manufacturer intends to make
these available in all countries in which it operates. Any reference to a product, program, or service is not intended to
state or imply that only that product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any existing intellectual property right may be used instead. Evaluation and verification
of operation in conjunction with other products, programs, or services, except those expressly designated by the
manufacturer, are the user’s responsibility.

For Lexmark technical support, visit support.lexmark.com.

For information on supplies and downloads, visit www.lexmark.com.

If you don't have access to the Internet, you can contact Lexmark by mail:

Lexmark International, Inc.
Bldg 004-2/CSC
740 New Circle Road NW
Lexington, KY 40550
USA

© 2010 Lexmark International, Inc.

All rights reserved.

UNITED STATES GOVERNMENT RIGHTS
This software and any accompanying documentation provided under this agreement are commercial computer
software and documentation developed exclusively at private expense.

Trademarks
Lexmark and Lexmark with diamond design are trademarks of Lexmark International, Inc., registered in the United
States and/or other countries.

All other trademarks are the property of their respective owners.
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Federal Communications Commission (FCC) compliance information statement
This product complies with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. Operation is
subject to the following two conditions:

1 this device may not cause harmful interference, and

2 this device must accept any interference received, including interference that may cause undesired operation.

Any questions on this statement should be directed to:

Director of Lexmark Technology & Services
Lexmark International, Inc.
740 West New Circle Road
Lexington, KY  40550
(859) 232-3000

For additional compliance information, see the online documentation.

Federal Communications Commission (FCC) compliance information statement
This product complies with Part 68 of the FCC Rules. See the product online documentation for additional compliance
information.
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